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FPS QUICK REFERENCE GUIDE

Fiber Processing Software (FPS) for the FSM-100 Splicer
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DATA COLLECTION APPLICATION

The Data Collection application is used to collect various, user-specified splicer output data, to
N include loss estimation and power meter measured loss data after a splice is completed. This

application gives users a tool to optimize splice mode parameters for improved splice loss and/
or PER performance. The collection of estimation data from the splicer, in-tandem with

I I measured loss, provides operators the ability to simultaneously optimize splice loss estimation
for process and quality control.

When the application is launched, it will enter the Main screen.

The main page contains four buttons as well as a switch for enabling Power Meter measurement and an option to
collect IPA data. Their functions and layouts are shown in Figure 1.

When pressed for the first time, both Collect Data (Single) and Run Auto Collection will both prompt you to
choose a location to save data. The former will first collect data before prompting, while the latter will not
allow you to proceed before selecting a save location. FPS will save data collection instances as “.dafl2” files by
default; so in order to save to an Excel file, click File, then in the drop-down menu click Save as Excel File and
save to the desired location.

Data Collection: Default File < JJjj ' Save now | ——— ()

File- Options-

! You haven't set a save location. Would you like to set one now to enable
Main Data Loss Estimation l IPA auto-saving?

Controls

COLLECT DATA| RUN AUTO

(SINGLE) COLLECTION Figure 2

Data Screencap (LQ)
Live Screencap (HQ) /

Measure Loss (GPIB)

Measure Loss (USB)

* Collect Data Only
ICollect IPA Data

Figure 1

Figure 2 above shows the save prompt that launches on first run.

Collect Data (Single): Will collect parameters specified on the Data tab, as well as pre-arc, WSI, and post-arc
images. To collect splice data, the splicer must be in the “Finish” state after completing a splice. The file
previously saved will be automatically updated each subsequent time the Collect Data (Single) button is pressed.

Run Auto Collection: FPS will begin polling the splicer, checking if it is in a "Finish" state. If so, FPS will
automatically perform a Data Collection and update the selected or previously saved file. NOTE: Auto collection
cannot be run without an autosave location.

Data Screen-cap(LQ): Saves the current splicer image at 240x320 to the same folder as the data file. If no data
file folder has been chosen, you will be prompted to choose a location for the images.
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Live Screen-cap(HQ): Saves the current splicer image at 480x640 to the same folder as the data file. This image is
ONLY of the camera feed; no menus or overlays are captured. If no data file folder has been chosen, you will be
prompted to choose a folder for the images.

This file-save will determine the folder that all images are saved to. The save location can be changed later by
performing a File»Save As... or loading a different Data Collection file.

Measure Loss (GPIB)/Measure Loss (USB)/Collect Data Only: A GBIP (General Purpose Interface Bus) or USB
Power meter stream is required in order to measure loss rather than estimate loss.

* When checking the Measure Loss (GPIB) button, you will be warned that failure to connect a GPIB will result in a
Communication Error, which will crash FPS and erase your data.

* If connected correctly, the splicer will read the value from the power meter and report it in a “Measured Loss”
column in the Data tab, as well as in the Loss Estimation tab.

 Alternatively, by selecting Measure Loss (USB), the splicer will collect measured loss data by attempting to read
a currently streaming USB power meter via the Power Meter Reader application in FPS. Collecting data with
this function activated will capture the live reading from the power meter. Because the Measure Loss (USB)
function captures a live reading, a reference value must be saved on the power meter before attempting to
measure splice loss.

* Post splice, the loss value may change if the splice is moved; therefore, data should be collected while the
connected power meter is streaming to FPS and before disturbing the finished splice in any way.

Collect Data Only: Retrieves splicer output parameters only and will not retrieve measured loss.

Collect IPA Data: Retrieves IPA data for a given splice. If this box is checked and there is no IPA data to be
retrieved, it will be ignored.

Figure 3 below shows a sample of 25 splices run and collected with COLLECT MODE (SINGLE) and the results
subsequently populated on the data screen.

Within the Excel file, Splice Data, Loss Estimation Data, and IPA Data will be available depending on what data
was collected.

Data Collection: Demonstration.daft2 |

File* Options*

Main Data Loss Estimation IPA Data
Controls

g
Measure Loss (GPIB) . / \
Measure Loss (USB)
* Collect Data Only

Collect IPA Data

Latest Results
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Measured Loss: @0

Estimated Loss: 0M0RN

Offset Loss: -

Deformation Loss: -

Prearc-X Prearc-Y WSI-X WsI-Y Postare-X Postarc-Y

Figure 3
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DOWNLOAD/UPLOAD APPLICATION

The Download/Upload application allows users to change, store, and transfer splice mode
parameters using PC control.

Modes  Util

I
[+ =l 2 ]

1 Mode * Range

Furthermore, Download/Upload a “.mafl” file to manage splice mode parameters. FPS is
compatible with previously saved SpliceLab and Pre-FPS 2.0 Upload/Download forms, as ecelve from Spricer

well as provided templates.
Send to Splicer

When opening Download/Upload for the first time, the user will see an empty table Save File
and a sidebar containing controls to receive and upload from the splicer as well as other
controls to save, load, and export the table. Load File

When the Download/Upload application is opened, the Range option is selected by
default which allows from 1 to 300 modes to be sent or received. Alternatively, select Export Excel
the 1 Mode option to send or receive one specific splice mode, e.g. (Mode 53).

Figure 4 shows the Download/Upload application box with the Range option selected. Figure 4
In this instance, FPS can either receive or send splice modes 1-2.

Figure 5 shows the main page with Download/Upload application after requesting modes 1 to 10 to be received
with each mode populating subsequent columns in the table field.

Download/Upload -

File-
Modes Util
1 wm 10 | hFllod: NumbterIs = 1 2 3 4 5 6 7 8 9 10
1ioas GRan Eanne undamental Settings

Fiber Type PMAUT... PMAUT.. PMAUT.. PMAUT.. PMAUT.. PMAUT.. PMAUT.. PANDA1 PANDA2 PANDA3
Mode Title 1 PM AUT... PM AUT... PM AUT... PM AUT... PM AUT... PM AUT... PM AUT... PANDA... PANDA... PANDA.
Mode Title 2 L=9m.. L=4m.. L=9m.. L=9m.. L=9m.. L=9m.. [L=9m.. L=9m.. L=4m.. L=9m.

Receive from Splicer

Operating Mo... FULL FULL FULL FULL FULL FULL FULL FULL FULL FULL
Electrode Gap 1.0 1.0 1.0 3.0 1.0 1.0 1.0 1.0 1.0 1.0
V Height Shift 0 0 0 0 0 o (4] 0 0 0
Save File Arc Calibratio... STD STD SP sP STD STD STD STD STD SP
Auto Arc Cali... OFF OFF OFF OFF OFF OFF OFF OFF OFF OFF
Load File Auto Stuff Co... ON ON ON ON ON ON ON ON ON ON
Arc Center C... OFF OFF OFF OFF OFF OFF OFF OFF OFF OFF
Export Excel Fiber Type C... OFF OFF OFF OFF OFF OFF OFF OFF OFF OFF

Fiber Data L NOTSE... NOTSE... NOTSE... NOTSE... NOTSE... NOTSE... NOTSE... NOTSE... NOTSE... NOTSE..
Fiber Data R NOTSE.. NOTSE.. NOTSE.. NOTSE.. NOTSE.. NOTSE.. NOTSE.. NOTSE.. NOTSE.. NOTSE.

Proof Test 100 100 OFF 100 100 100 100 100 100 OFF
Uneven Melt... OFF OFF OFF OFF OFF OFF OFF OFF OFF OFF
Splice Before... NO NO NO NO NO NO NO NO NO NO

Clamp Action AUTO AUTO AUTO AUTO AUTO AUTO AUTO AUTO AUTO AUTO
Except Z Sta... PREDE... PREDE.. PREDE.. PREDE.. PREDE.. PREDE.. PREDE.. PREDE.. PREDE.. PREDE...
SP Arc Calibr... NONE NONE NONE NONE NONE NONE NONE NONE NONE NONE
Precise Motor... OFF OFF OFF OFF OFF OFF OFF OFF OFF OFF
Electrodes W... 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0
Initial Sweep... CENTER CENTER CENTER CENTER CENTER CENTER CENTER CENTER CENTER CENTER

STOP Z Stages PREDE... PREDE... PREDE.. PREDE.. PREDE.. PREDE.. PREDE.. PREDE.. PREDE.. PREDE..
Left Fiber Information

Ready we—

Figure 5
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The user can also send either downloaded or modes loaded from a “.mafl” file or appropriate excel template file
and are able to select the range of columns to send in the same manner as selecting which ones to receive from
the splicer.

Figure 6 Shows the popup window that will allow the user to choose a Range or 1T Mode destination column(s) to
overwrite.

& SendDestination — O X

Overwrite modes # to # with data in Mode file?

This cannot be undone!

OK Cancel

Figure 6

Figure 7 Shows an example of the exported mode columns into an excel file.

Group Parameter Title Code Attribute 1 2 3 4 5 6
Fiber Type FIBERTYPE PMAUTO1 PMAUTO2 PMAUTO3 PMAUTO4 PMAUTOS PMAUTO6
Mode Title 1 MODETITLEL PMAUTO 1 PMAUTO 2 PMAUTO3 PMAUTO 4 PM AUTO 5 PMAUTO 6
Mode Title 2 MODETITLE2 L=9mm 250um L=4mm 250um L=9mm 165um L=9mm 900um L=9mm AT P-Stop : L=9mm XYP-Align :L
Operating Mode OPERATINGMODE FULL FULL FULL FULL FULL FULL
Electrode Gap ELECTRODEGAP 1.0 10 1.0 3.0 1.0 10
2 V Height Shift VHEIGHTSHIFT 0 0 0 0 0 0
E Arc Calibration Method ARCCALIBRATIONMETHOD STD STD SP SP STD STD
4 Auto Arc Calibration AUTOARCCALIBRATION OFF OFF OFF OFF OFF OFF
5 Auto Stuff Control AUTOSTUFFCTRL ON ON ON ON ON ON
6 Arc Center Compensation ARCCENTERCOMPENSATION OFF OFF OFF OFF OFF OFF
7 Fiber Type Compare FIBERTYPECOMPARE OFF OFF OFF OFF OFF OFF
Fundamental Settings: Fiber Data L FIBERDATAL NOTSELECTED NOTSELECTED NOTSELECTED NOTSELECTED NOTSELECTED NOTSELECTED
Fiber Data R FIBERDATAR NOTSELECTED NOTSELECTED NOTSELECTED NOTSELECTED NOTSELECTED NOTSELECTED
2 Proof Test PROOFTEST 100 100 OFF 100 100 100
2 Uneven Melt Detection Thr. UNEVENMELTDETECTIONTHR OFF OFF OFF OFF OFF OFF
Splice Before Shaping SPLICEBEFORESHAPING NO NO NO NO NO NO
Clamp Action CLAMPACTION AUTO AUTO AUTO AUTO AUTO AUTO
4 ExceptZ Stages EXCEPTZSTAGES PREDEFINED PREDEFINED PREDEFINED PREDEFINED PREDEFINED PREDEFINED
25 SP Arc Calibration Ref SPARCCALIBRATIONREF NONE NONE NONE NONE NONE NONE
26 Precise Motor Drive PRECISEMOTORDRIVE OFF OFF OFF OFF OFF OFF
27 Electrodes Wear Coef ELECTRODESWEARCOEF 1.0 1.0 10 1.0 1.0 1.0
28 Initial Sweep Position INITIALPOSSWP CENTER CENTER CENTER CENTER CENTER CENTER
29 Z Stages ZSTAGES PREDEFINED PREDEFINED PREDEFINED PREDEFINED PREDEFINED PREDEFINED
Coating Diameter LCOATINGDIAMETER 250 250 165 900 250 250
Clad Diameter LCLADDIAMETER 125 125 80 400 125 125
Clad Diameter 2 LCLADDIAMETER2 125 125 80 400 125 125
Left Fiber Information: Core Diamter LCOREDIAMETER 8.2 8.2 8.0 8.2 8.2 8.2
4 MFD LMFD 10.5 10.5 9.5 10.5 10.5 10.5
Clamp At LCLAMPAT AUTO AUTO AUTO AUTO AUTO AUTO
6 Cleave Length LCLEAVELENGTH 9mm 4mm 9mm 9mm 9mm 9mm
7 Coating Diameter RCOATINGDIAMETER 250 250 165 900 250 250
Figure 7

NOTE: If the user needs to manually edit columns for any reason this can be done by exporting the modes as an
Excel file, then using Excel to edit any cells and/or columns needed. Afterwards saving and loading the
edited Excel file back into the Download/Upload application and sending the edited columns back to the
splicer. ITIS RECOMMENDED TO MAKE A BACKUP OF THE UNEDITED EXCEL AND/OR “.mafl” FILE BEFORE

DOING THIS.
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LIVE VIDEO FEED APPLICATION

The Live Video application displays a live video feed from the splicer. By default, video will begin
streaming when the PLAY button is pressed.

To save screen images, click Screencap as shown in Figure 8. The live feed will stop, and the “Save As" dialog box
will prompt the user to choose the file location for the captured image to be saved. The video feed will resume
when the dialog box is closed.

Unless a save location is otherwise defined, images will be saved in “.bmp"” format to the Documents library by
default.
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Figure 8

NOTE: \While live video is running, it will interrupt any other FPS program that is trying to control the splicer. For
example, if the Live Video application is open and the Ball Lens program is started, upon clicking Initiate or
Start, FPS will respond with an error message, citing an error communicating with the splicer. In order to
use a different FPS application, Live Video must be closed.
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POWER METER READER APPLICATION

The Power Meter Reader application allows for reading of select USB Power Meters. This
application sends the power meter readings to the splicer for performing active fiber alignments
based on a max, min, or target loss condition, as defined by the user.

Parabolic Alignment constructs a graphical plot of the measured loss value vs. relative (X, Y) position of the two
fibers. Selecting Para Align prompts the splicer to execute two subsequent scans of the fibers’ relative end face
positions — first, a rough scan (StepL) and second, a fine scan (StepF). From the initial scan, the resulting graph is a
rough parabola, wherein the minimum or maximum value is used to establish a new approximate range of X and Y
fiber position values for optimum alignment. The program then performs the fine scan, where the (X, Y) range
established from the rough scan is scanned again at finer intervals, defined by the input value for StepF. When
parabolic alignment is complete, the optimal (X, Y) position and the optimal loss value are displayed.

Figure 9 shows the value the splicer will use for performing an active alignment, discussed below. To set up active
alignment with a splicer, follow the splicer setup and power meter setup steps outlined in the FPS instruction
manual.

PowerMeterReader - [ ——

Power Meter: |Thorlabs PM100D
START STREAM
ACTIVE ALIGN STOP STREAM

23.924dB

Parabolic Alignment
PARA ALIGN StepL (um):|3 StepF (um): |1

* Max
STOP PARA

Min
CONNECTED

Figure 9

By default, FPS only supports the AFL OPM5, though other power meter drivers are available and new drivers can
be developed if needed. Once the power meter’s drivers are installed, simply clicking the Start Stream button will
establish a connection and show loss in dB in the “PowerMeterReader” window.
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As shown in Figure 10, use the Active/Stop Align, Read
Relative, and Start/Stop Stream buttons to manage the
active alignment procedure from the FPS interface. The
splicer settings must be modified according to the FPS
instruction manual. If not, the splicer will be unable to
execute the active alignment procedure.

To set up Parabolic Alignment in a connection through
a PC, follow the steps in the FPS Instruction Manual.

In most cases, parabolic alignment is faster than
standard splicer alignment and does not require a
specific setup in the splicer. Parabolic alignment
collects a range of loss values from the power meter
and plots a vertical parabola of the values. After the
initial parabola is plotted, a finer scan of the data near
the parabola minima, or maxima, is completed to
assess the min. or max. loss.

PowerMeterReader - [——

Thorlabs PM100D
READ RELATIVE ’ S

Power Meter:

-7.368dB

Figure 10
Parabolic Alignhment
StepL (pm): |3 StepF (pm): |1
* Max
Min
CONNECTED
Figure 11

The following parameters shown in Figure 11 can be customized as needed:

* Max/Min: Power meters may sign their losses differently depending on the manufacturer.
* Max should be selected if your Power Meter reports a negative value (i.e., moving from an initial loss of

-10dBm to -1dBm).

e Min should be selected if your power meter reports a positive value (i.e., moving from an initial loss of 10dB

to 1dB).

e StepL (um) is the distance moved with each iteration during the Rough Alignment phase. The larger this value,

the larger and less precise the rough search area will be.

e StepF (um) is the distance moved with each iteration during the Fine Alignment phase. It should be less than the

StepL value to refine the initial results.

NOTE: Take special care to ensure that the proper OPM drivers are installed on the PC. OPM driver software
should have been supplied on a USB drive or CD with the purchase of the power meter. If the OPM driver is
not installed on the PC, FPS will be unable to connect to the power meter and will display an error.

TECHNICAL SUPPORT INFORMATION

If errors persist or if general support is needed, please call AFL Fusion Splicer Technical Support at 1-800-866-3602,

or visit our Technical Support Request web page.
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